
LizardTech

GeoGofer
User Manual



Copyright © 2009–2014 Celartem Inc. d.b.a. LizardTech®. All rights reserved. Information in this

document is subject to change without notice. The software described in this document is fur-

nished under a license agreement or nondisclosure agreement. The software may be used or

copied only in accordance with the terms of those agreements. No part of this publication may be

reproduced, stored in a retrieval system, or transmitted in any form or anymeans electronic or

mechanical, including photocopying and recording for any purpose other than the purchaser's per-

sonal use without the written permission of LizardTech.

LizardTech, MrSID, GeoExpress and Express Server are registered trademarks in the United

States and the LizardTech, GeoExpress, Express Server, ExpressView and GeoViewer logos are

trademarks, and all are the property of Celartem Inc. d.b.a. LizardTech. Unauthorized use is pro-

hibited.

LizardTech acknowledges and thanks the many individuals and organizations whose efforts have

made our products possible. A full list of copyright, trademark and credit information is available

in the document "Copyrights, Trademarks, and Credits" installed automatically with your product.

LizardTech

1008Western Avenue, Suite 200

Seattle, Washington, USA 98104

206.652.5211

www.lizardtech.com

- ii -

http://www.lizardtech.com/


Preface

TheGeoGofer User Manual is written for geographic information system (GIS) professionals that

want to search and manage geospatial imagery with LizardTech GeoGofer. The guide assumes

basic knowledge of GIS, including knowledge of map projections and geospatial image formats.
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Product Overview

GeoGofer is a software solution for finding geospatial imagery, including raster imagery and

LiDAR imagery. GeoGofer stores and queries image information using the ArcGIS Online plat-

form.

Before you can search for images in GeoGofer, you must select the files or directories that you

want to import into the database. Information about the images, including the file location, pro-

jection, and more, is stored in the GeoGofer database on ArcGIS Online. You must have an

ArcGIS Online subscription to use GeoGofer.

To view information about the images in the database, use the Table pane. You can run queries

to filter the images that display in the Table pane. Create queries in theQuery Builder or type

queries into the search box. You can save the queries that you create and access them in the

Queries pane. You can also create a special kind of query called a tag. Tags are user-defined cat-

egories that you can use to label and organize images.

Additionally, you can use theMap pane to navigate to an image's location, then display inform-

ation about the image in the Table pane. When you right-click an image in the Table pane or the

Map pane, you can select actions to perform for the selected image. For example, you can zoom

to the location of the image.

System Requirements

Before you install GeoGofer, verify that your system meets the minimum system requirements.
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Operating System Requirements

You can install GeoGofer on 32-bit and 64-bit versions of the following operating systems:

l Windows 8

l Windows Server 2012

l Windows 7

l Windows Server 2008

Hardware Requirements

For optimal performance, verify that your system meets the following recommended hardware

requirements:

l 2.5 GHz processor

l 4 GB RAM

l 1 GB of disk space for installation

ArcGIS Online Requirement

GeoGofer stores and queries image information using the ArcGIS Online platform. To run

GeoGofer, you must have an ArcGIS Online subscription. For more information about

ArcGIS Online, navigate to the following URL:

http://www.esri.com/software/arcgis/arcgisonline/

Software Requirements

GeoGofer requires the following software to run:

l Microsoft .NET Framework 4.5

l Visual Studio C++ 2010 Redistributable

If this software is not installed on your machine, the GeoGofer installer installs the software for

you.

Additionally, you can use GeoGofer to open images in ArcMap and GeoViewer. ArcMap is an Esri

application for processing and analyzing geospatial data. GeoViewer is LizardTech's free viewing

application for raster and LiDAR imagery. To enable the functionality that allows you to open

images in ArcMap, ensure that you have ArcMap 10.1 or 10.2 installed. You can install ArcMap

before or after you run the GeoGofer installer. To enable the functionality that allows you to open
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images in GeoViewer, select the option in the GeoGofer installer to download and install the

GeoViewer software.

Getting the Software

When you purchase GeoGofer, you can download the software from an FTP site or you can install

from a DVD. The installation software contains a trial license and the GeoGofer documentation.

Installation

Run the setup.exe program to install GeoGofer.

1. Log on the machine where you want to install GeoGofer with administrator privileges.

2. Navigate to the directory where you downloaded the installer or insert the installation DVD

into your DVD drive.

3. Run the setup.exe program.

TheGeoGofer Installation Wizard appears.

4. The installation wizard prompts you to complete the following tasks:

l Accept the License Agreement.

l Select the directory where you want to install GeoGofer.

l Install the Microsoft .NET Framework and Visual Studio C++  Redistributable.

l Optionally, install GeoViewer, LizardTech's free raster and LiDAR viewer.

5. Click Finish to exit the installer.

Running GeoGofer

To run GeoGofer, click the desktop icon. Alternatively, click theWindowsStartmenu and click

Programs > LizardTech > GeoGofer.

When the application opens, GeoGofer prompts you to sign in to ArcGIS Online. For more inform-

ation on howGeoGofer uses ArcGIS Online and to configure ArcGIS Online, see ArcGIS Online

Administration on page 35.

IMPORTANT: GeoGofer sends some information to ArcGIS Online without encryption.

To enforce secure communication for all image information, configure your
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ArcGIS Online security settings before you runGeoGofer for the first time. For more

information, see ArcGIS Online Security on page 35.

Enter the following information to sign in to ArcGIS Online:

l Organization URL. The URL for your ArcGIS Online organization. For example, you

might enter the following URL:

https://myorganization.maps.arcgis.com/

l User Name. The user name for your ArcGIS Online account.
l Password. The password for your ArcGIS Online account.

The first time that you run GeoGofer, GeoGofer creates a database for your imagery on

ArcGIS Online, then prompts you to import imagery into the database.

Licensing

GeoGofer comes with a 14-day trial license. After 14 days, you must enter a permanent license

code.

Licensing codes are specific to your machine. You can request a permanent license from Liz-

ardTech Customer Support.

Requesting a Permanent License

To request a permanent license, complete the following steps:

1. Run GeoGofer by clicking the desktop icon or by click the Startmenu and clicking

Programs > LizardTech > GeoGofer.

GeoGofer starts.

2. On the Toolsmenu, click Licensing.

The Licensing dialog appears.

3. ClickCopy licensing information to clipboard to copy the locking code for your

machine.

4. Open a web browser and navigate to the following URL:

https://www.lizardtech.com/support/product-activation/
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5. Fill out the form and paste your locking code in the Locking Code field.

NOTE: LizardTech Customer Support will send you a license code within one

business day.

Switching to a Permanent License

To switch to a permanent license, complete the following steps:

1. Run GeoGofer as an administrator by right-clicking on the desktop icon and selectingRun

as administrator.

2. On the Toolsmenu, click Licensing.

The Licensing dialog appears.

3. Enter your license code in the License code field.

NOTE: The licensing change takes effect the next time that you start the pro-

gram.
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Imports and Exports Overview

The import process saves information in the GeoGofer database about the images that you

select. The export process copies images that you select to another directory for easy access.

GeoGofer does not modify the original images.

The following list describes some of the information that GeoGofer stores for each image in the

database:

l Image name

l File location

l Projection

l File format

l Size

l Date modified

l Number of bands

You can also export images to another directory for easy access.

Supported Image Formats

You can import raster and LiDAR imagery into GeoGofer.

The following table displays the file formats of the images that you can import:

Image Format Name File Extension

Bitmap .bmp
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Image Format Name File Extension

CADRG .cadrg, .toc

DOQQ .doq, .nes, .ses, .sws, .nws

DTED .dt0, .dt1, .dt2

ECW .ecw

GeoTIFF .tif, .tiff, .tifw, .tifg

Imagine .img

JPEG .jpg, .jpeg

JPEG 2000 .jp2, .jpc, .jpx, .jpf, .j2k

LAN .lan

LAS .las

MrSID .sid, .mg4, .mg3, .mg2

NITF .ntf, .nsf

PNG .png

Raw .bbb, .bil, .bip, .bsq, .raw

SunRaster .ras

Importing Imagery

To import imagery into GeoGofer, click the Import button in the Table pane. The Import
Files and Directories dialog appears.

In the Import Files and Directories dialog, clickAdd files to select individual images that you

want to import or clickAdd directory to import all of the images in a directory. Alternatively, drag

files or directories into the Import Files and Directories dialog.

TIP: If you only want to import images with a specific file format, click Tools

> Preferences in themenu bar to set the import preferences.
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Optionally, when you import images into the database, you can add a tag to the images. Use tags

to organize images and make it easier to find the images again. For more information on tags,

see Tags Overview on page 27.

When you are done selecting files and directories, click Import to begin the import process. The

progress of the import process is displayed in the status bar.

Reviewing Imported Imagery

When the import process finishes, you may want to ensure that the information stored in the

GeoGofer database is accurate and complete. You can change the status of an image to Verified

to keep track of the images that you review. If an image is missing projection information, you can

assign a projection.

Changing the Status of an Image

Each image that you import has a status. The status of an image is displayed in the Table pane.

The following list describes the possible values for the image status:

Imported

This is the default status for images that you import. Use this status to keep track of the images

that you need to review.

Verified

Optionally, use this status to indicate that an image's information is correct in the database. To

change the status of an image to verified, right-click on the record for the image in the Table

pane. Then, clickMark Verified.

Missing

This is the status of images that cannot be accessed byGeoGofer. For example, if you move or

delete an image and attempt to zoom to the image location in theMap pane, the status of the

image changes toMissing.

NOTE: To check whether any of the images in the database have beenmoved or

deleted, click Tools > Manage Database in themenu bar. Then, click Check for Modi-

fied or Missing Files.
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Assigning Projection Information

Images without projection information cannot be displayed in theMap pane. To assign a pro-

jection to an image, select from a list of projections or enter a custom well known text (WKT)

 string.

If you import an image without projection information, or if GeoGofer cannot read the projection

information, the image is displayed in bold in the Table pane. When you assign a projection to an

image, the projection information that you enter is written to an auxiliary file in the same directory

as the image. GeoGofer uses the auxiliary file to display the location of the image in theMap

pane. If the image directory is read-only, GeoGofer cannot write an auxiliary file in the same dir-

ectory. Instead, GeoGofer stores the file separately and changes the AlteredSRS field for the

image to 1.

TIP: To find all of the images in the GeoGofer database that aremissing projection

information, you can select the HasGeometry:False query in theQuery Builder. For

more information, see TheQuery Builder on page 19.

To assign a projection for the image, complete the following steps:

1. Right-click on the image and clickChange Projection.

The Select Coordinate Reference System dialog appears.

2. In the search box, enter the name of the coordinate reference system that you want to

assign.

GeoGofer returns a list of matching projections.

3. Click one of the coordinate reference systems that appear.

4. If the coordinate reference system cannot be found, select theUse custom WKT option

and enter a custom WKT in the text box.

5. ClickOK.

NOTE: You can also change the projection of images that already display a projection.

For these images, the projection information is used to display the image in theMap

pane. If you export an image for which you have changed the projection, the changed

projection information is stored in an auxiliary file rather than in the image itself.

- 10 -



Chapter 2: Imports and Exports

Re-Importing Imagery

If you change an image on the file system, you can import the image again to update the

GeoGofer database.

When you import an image more than once, GeoGofer reads the image information and updates

the database if the image has changed. If you have manually changed the projection for an image

in the database, GeoGofer preserves the changed projection.

Exporting Imagery

When you export an image from GeoGofer, you make a copy of the image in another directory for

easy access.

To export imagery, select one or more images that you want to export in the Table pane. Then,

click the Export button in the Table and select the directory where you want to save the
exported imagery. The images that you export are saved with the following naming convention:

<original image name>_<image ID>.<image extension>

For example, if you export an image named Seattle.sid, the exported image might be saved

as Seattle_40.sid.

NOTE: For an image that you export, if you previously assigned another projection to

the image in GeoGofer, the export process also creates an auxiliary file for the image.

For more information on assigning a projection to an image, see Assigning Projection

Information on page 10.
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User Interface Overview

Use the GeoGofer graphical user interface to import image information, to search for images, to

display the image locations on a map, and more.

The following figure displays the GeoGofer user interface:
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1. Menu Bar

2. Map Toolbar

3. Map Pane

4. Queries Pane

5. Table Toolbar

6. Table Pane

7. Status Bar

The location of theMap pane, the Table pane, and theQueries pane can be customized by click-

ing on the title of each pane, and dragging the pane to another location. To reset the location of

each pane to the default location, click Tools > Preferences. Then, in the Preferences dialog,

clickRestore Default Window Layout.

Menu Bar

Use the menu bar to perform management tasks, to set preferences, to enter licensing inform-

ation, and to access the help interface.

The following table describes some of the options that you can access from the menu bar:

Option Description

File > Import Save information in the database about the files and directories that you select.

File > Export
Select a directory to which you want to copy the images that are currently selected in

GeoGofer.

Tools

> Preferences

Set themaximum number of files to display in the table, select a basemap, select the file

formats that you want to import, and set preferences for the log file.

Tools > Manage

Database

Clear the GeoGofer database and checkwhether anyof the images in the database have

beenmoved or deleted.

Tools > Manage

Queries
Create queries, delete queries, and edit existing queries.

Tools > Manage

Tags
Create tags, delete tags, and edit existing tags.

Tools

> Licensing
View your locking code and enter a license code.
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Map Toolbar

TheMap Toolbar displays controls for the map.

TheMap Toolbar includes a search box that you can use to zoom to a location on the map. For

example, you can search for the name of a city or a country. To zoom to the location of an image,

run a search in the Table pane, right-click the image, then click Zoom to.

Click theHome button to zoom to the full map extent. Click theHide Extents button to
remove the rectangular image extents for each image from the map. Click theHide Clusters but-

ton to remove the clusters from the map. To display the extents or clusters on the map after
they have been hidden, press theHide Extents orHide Clusters button again.

Map Pane

Use theMap pane to browse imagery on a single map. The images in theMap pane correspond

to images in the Table pane. If you select an image on the map, it is also selected in the Table

pane.

If multiple images on the map are in close proximity, the images are grouped together in a cluster.

Click on a cluster to zoom to the aggregate extents of the component images. If the cluster con-

tains five images or fewer, you can rest the mouse pointer over the cluster to display a list of the

component images. To hide the image clusters, click theHide Clusters button in the
Map Toolbar.

When you zoom to an image, the map displays a rectangle of the extents of the image. To hide

the image extents, click theHide Extents button in theMap Toolbar. You can right-click on
an image to perform additional actions for the image. For example, you can zoom to the image

and display information about the image.

TIP: To select multiple images on themap, hold theControl key and click on the

images that you want to select. If you right-click on one of the images in the selection

and click Zoom to, the selected action applies to all the images in the selection. If you

right-click on one of the images in the selection and click Details, the dialog that

appears only displays information about the image that was selected last.
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Queries Pane

TheQueries pane contains a list of saved queries. Queries are criteria that you can use to filter

the images that display in the table and on the map.

Click on a query in theQueries pane to run the query. To add, edit, or delete queries, right-click in

theQueries pane and clickManage Queries. You can also use theQuery Builder in the
Table pane to add queries. For more information on queries, seeQueries Overview on page 19.

NOTE: The queries that you create can include tags, which are a convenient way of cat-

egorizing images . To add, edit, or delete tags, right-click in theQueries pane and click

Manage Tags. For more information on tags, see Tags Overview on page 27.

Table Toolbar

The Table Toolbar displays controls for the Table pane. Use the toolbar to search for images in

the table, to import imagery, and to perform operations on the images that you select in the table.

Use the search box in the Table Toolbar to search the file name and file path of images in the

table. To limit the results of a search to the images currently visible on the map, select theMap

Extent check box. For example, you want to search for images in the Seattle area that include

NAIP in the title. Use the map to zoom to the Seattle area, select theMap Extent check box, and

enter NAIP in the Table Toolbar search box.

In addition to searching the table, you can perform the following operations in the Table Toolbar:

Operation Icon Description

Build query
Search byadvanced criteria and enter multiple search criteria. For more inform-

ation on queries, seeQueriesOverview on page 19.

Import
Select the images for which you want to store information in the GeoGofer data-

base. For more information, see Imports and ExportsOverview on page 7.

Zoom to Zoom to the location of the selected image or images in theMap pane.

Details

Displayadditional information about the currently selected image. If more than

one image hasbeen selected, GeoGofer displays information about the image

that was selected last.

- 16 -



Chapter 3: User Interface

Operation Icon Description

Tag
Apply a tag to the currently selected image or images. For more information, see

TagsOverview on page 27.

Mark verified

Change the statusof an image toVerified to keep trackof the images that you

have reviewed. For more information, seeReviewing Imported Imageryon page

9.

Export Copy the currently selected image or images to a directory that you specify.

Change projection

Change projection information for the selected image or images in the GeoGofer

database. For more information, seeAssigning Projection Information on page

10.

Open file location

Display the directory that contains the selected image or images. If more than one

image hasbeen selected, GeoGofer displays the directory that contains the

image that was selected last.

Open in ArcMap
Open the selected image or images in ArcMap. If ArcMap is not installed, this oper-

ation is not available.

Open in GeoViewer
Open the selected image or images in GeoViewer. Bydefault, GeoViewer is

installed aspart of the GeoGofer installation process.

Delete
Delete the selected image or images from theGeoGofer database. This oper-

ation doesnot delete the image from the file system.

Columns Select the columns that you want to display in the Table pane.

NOTE: Many of the operations in the Table Toolbar are only available when you have

selected one or more images in the Table pane.

Table Pane

The Table pane displays information about the images stored in the GeoGofer database. To filter

the images that display in the Table pane, use the search box in the Table Toolbar or click on a

saved query in theQueries pane. The images in the Table pane correspond to images in the

Map pane.
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To select multiple images in the Table pane, hold theControl key and click on the images that

you want to select. Alternatively, when you select one or more images in theMap pane, the

image or images are automatically selected in the Table pane as well. Right-click on selected

images in the Table pane to perform operations on the selected images. The operations in the

right-click menu match the operations in the Table Toolbar. For example, you can zoom to the

selected images.

The columns in the Table pane are sortable and customizable. You can drag the columns to re-

order them. Additionally, to change the columns that you want to display, click theColumns but-

ton in the Table Toolbar.

The lower-left corner of the Table pane displays information about the number of images, or

records, that are currently displayed in the Table pane. If the number of records in the database

exceeds a specified maximum for the table, the records are displayed on multiple pages. Click the

forward and backward arrows to move between pages. By default, the Table pane displays up to

10,000 records at a time. To change the maximum number of records that appear for each page,

clickPreferences on the Toolsmenu and enter another value in theMax Records field.

Status Bar

The status bar displays information for the operations that you run. For example, when you import

imagery into GeoGofer, the status bar displays the progress of the import operation.

The status bar displays information about the following operations:

l Import operations

l Export operations

l Tag operations

l Query operations

Additionally, for large operations, the status bar includes a Stop button to cancel the current
operation.
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Queries Overview

Queries are criteria that you can use to filter the images that display in the table and on the map.

Run queries from the Table pane. You can create a query that you want to run in theQuery

Builder or you can enter a querymanually in the search box.

NOTE: By default, when you enter a value in the search box, GeoGofer compares the

value against the file name and file path. To enter other queries manually, seeQuery

Components on page 20.

Save queries that you use frequently to theQueries pane. To add, edit, or delete queries, right-

click in theQueries pane and clickManage Queries.

The Query Builder

TheQuery Builder is a graphical user interface that you can use to create queries.

To access theQuery Builder, click theBuild Query button in the Table pane. Use the
drop-down boxes to create the query. To enter multiple search criteria, click theAdd Query Row

button . For more information on the search criteria that you can select, seeQuery Com-
ponents on page 20.

To save the queries that you create in theQuery Builder, select the Save as query option

before you clickSearch. Saved queries appear in theQueries pane.
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Query Components

Queries that you create in theQuery Builder consist of search fields, operators, search values,

and search logic. Learn the components of a query to create more advanced queries and to enter

queriesmanually.

The following figure shows the components of a query in theQuery Builder:

1. Search Fields. The image attribute that you want to search.
2. Operators. The way that you want to compare the search value against the search field.

The available operators depend on the field that you select.

3. Search Values. The value that you want to search for. For some search fields, the search

value field changes to a drop-down or date picker.

4. Search Logic. The way that you want to display results for multiple search criteria.

You can view the text representation of a query in theQuery text field. To run queries quickly,

you can enter the query text directly into the search box of the Table pane.

Search Fields

A search field describes the type of image information that you want to search. Search fields can

include image metadata, like projection information, and file information, like the location of the
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image. The name of a search field is the same in theQuery Builder drop-down box and in the

query text.

The following table describes the search fields that you can select in theQuery Builder:

Search Field

Name
Description

AlteredSRS

A flag to indicate that the coordinate reference system for the image waschanged in GeoGofer,

but could not be saved to an auxiliary file alongside the image. The only possible value is 1, oth-

erwise the field is blank. For more information, seeAssigning Projection Information on page 10.

Bands The number of bands included in the image. Alpha bandsare included in the number of bands.

BitDepth The number of bits in each band of the image. Values include, but are not limited to, 8 and 32.

BoundsP0_X The X coordinate of the first point for the image extent.

BoundsP0_Y The Y coordinate of the first point for the image extent.

BoundsP1_X The X coordinate of the second point for the image extent.

BoundsP1_Y The Y coordinate of the second point for the image extent.

BoundsP2_X The X coordinate of the third point for the image extent.

BoundsP2_Y The Y coordinate of the third point for the image extent.

BoundsP3_X The X coordinate of the fourth point for the image extent.

BoundsP3_Y The Y coordinate of the fourth point for the image extent.

Channels
The number of image channels or fields for a LiDAR image. For example, a typical LiDAR image

will have channels for X, Y, Z, and intensity valuesamong others.

ColorSpace
The color space of the image. For example, youmight enter RGBA for an image with red, green,

blue, and alpha bands.

CR
The compression ratio of an image. For example, youmaywant to find images that have a com-

pression ratio greater than 10.

DatasetType The type of image. Values include Raster and PointCloud.

DataType

The data type of the image. An imagemaybe signed or unsigned, and it mayuse integer or float-

ing point values. For example, to find all unsigned integer images, youmight search for images

whose data type containsUINT.
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Search Field

Name
Description

EPSG The EPSG code of the image.

FileDate The date that the file was last modified. If you select this search field, a date picker appears.

FileSize
The size of the file. If you select this search field, an additional drop-down appearswith unit inform-

ation.

Format
The file format. For example, youmight enter MrSID or JPEG 2000. For a full list of supported file

formats, clickTools > Preferences, then click Imports.

GeoX
One coordinate of the upper left point in the image. For imageswith latitude and longitude values,

this corresponds to the longitude.

GeoY
One coordinate of the upper left point in the image. For imageswith latitude and longitude values,

this corresponds to the latitude.

HasGeometry
Whether the image hasprojection information. If you select this search field, the search value field

changes to a drop-down box that restricts values to True or False.

Height The height of the image in pixels.

NoData

The no data value for an image. Values include AllMin, AllMax, None, and Custom. For example,

8-bit imageshave values from 0 to 255. If the no data value is 0, this corresponds to AllMin. If the

no data value is 255, this corresponds to AllMax.If the no data value is 73, this corresponds to Cus-

tom.

Path The file path.

Points The number of points in a LiDAR point cloud.

Status
The statusof the image. Values include imported, verified, or missing. For more information, see

Changing the Statusof an Image on page 9.

Tag The list of tagsapplied to the image.

Width The width of the image in pixels.

WKT TheWell Known Text (WKT) string of the image.

XRes The X resolution of the image.

XRot The X rotation of the image.

YRes The Y resolution of the image.
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Search Field

Name
Description

YRot The Y rotation of the image.

TIP: To find images with an alpha band, search for images with a color space that ends

with A. For example, youmight enter the following query text:

ColorSpace:$A

Operators

An operator determines how search values are compared against the search field. The available

operators depend on the search field that you select.

Some of the operators use the same syntax, but have different meanings depending on the

search field. The following table describes the operators that you can select in theQuery

Builder:

Operator

Name

Operator

Query Text
Description

After :>
For datesonly. The date in the search field is after the date that you enter as the

search value.

Before :<
For datesonly. The date in the search field is before the date that you enter as the

search value.

Contains : The search value is included somewhere in the search field.

EndsWith :$ The search field endswith the search value.

Equals := The search field is equal to the search value.

Greater

Than
:> The search field is greater than the search value.

Is :
The search field is equal to the search value. This operator is for search fields that

can only have true or false values.

LessThan :< The search field is less than the search value.

Not Equals :! The search field equals anything except for the search value.

On : For datesonly. The date in the search field is the same as the date that you enter
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Operator

Name

Operator

Query Text
Description

as the search value.

StartsWith :^ The search field beginswith the search value.

Search Values

A search value is the value that you want to search for. For some search fields, the search value

field changes to a drop-down or date picker.

Search Logic

Use search logic to determine the way that you want to display results for multiple search criteria.

You can select And orOr.

Select And to display the query results that match all of your criteria. Select Or to display the

query results that match one or more criteria.

Query Management

To add, edit, and delete queries, right-click in theQueries pane and clickManage

Queries. Alternatively, clickManage Queries on the Toolsmenu.

You can also use theManage Queries dialog to apply a tag to the image results for a query. For

more information, see Applying a Tag to Query Results on page 29.

Adding a Query

Add new queries from the Table pane or from theManage Queries dialog.

To add a query from theManage Queries dialog, complete the following steps:

1. Right-click in theQueries pane and clickManage Queries.

2. Click theAdd Query button .

TheAdd Query dialog appears.

3. Use the drop-down boxes to create the query. To enter multiple search criteria, click the
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Add Query Row button .

4. ClickAdd to create the query.

Editing a Query

Edit a query to add, edit, or delete search criteria.

To edit a query, complete the following steps:

1. Right-click in theQueries pane and clickManage Queries.
2. Select the query that you want to edit.

3. Click the Edit Query button .

The Edit Query dialog appears.

4. Add, edit, or remove search criteria.

5. ClickSave.

Deleting a Query

You can delete one or more queries at a time.

Complete the following steps to delete a query:

1. Right-click in theQueries pane and clickManage Queries.
2. Select one or more queries that you want to delete.

3. Click theDelete Tag button .
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Tags Overview

Tags are user-defined categories that you can use to label and organize images. You can apply

multiple tags to the same image.

By default, when you create a tag, the tag is also saved as a query. The tag then appears in the

Queries pane as a convenient way of viewing all the images that have that specific tag.

Applying a Tag to an Image

You can apply tags to the images that you select in the Table pane.

To apply a tag to an image, complete the following steps:

1. In the Table pane, select one or more images to which you want to apply a tag.

2. Click the Tag Selected Files button .

The Tag interface appears.

3. Search for an existing tag or clickCreate New to create another tag.

TIP: To create a tag quickly, enter the name of the tag that you want to create in the

search box of the Tag interface, then press enter.
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Tag Management

To add, edit, and delete tags, right-click in theQueries pane and clickManage Tags. Altern-

atively, clickManage Tags on the Toolsmenu.

Adding a Tag

Add new tags from the Table pane or from theManage Tags dialog.

To add a tag from theManage Tags dialog, complete the following steps:

1. Right-click in theQueries pane and clickManage Tags.

2. Click theAdd Tag button .

TheAdd Tag dialog appears.

3. Enter a name for the tag and an optional description.

NOTE: By default, the tag is also saved as a query so that you can access it

from theQueries pane. If you do not want the tag to appear in theQueries pane,

clear theSave as query option.

Editing a Tag

Edit a tag to change the name or description of a tag. You can also edit a tag to remove the tag

from theQueries pane.

To edit a tag, complete the following steps:

1. Right-click in theQueries pane and clickManage Tags.
2. Select the tag that you want to edit.

3. Click the Edit Tag button .

The Edit Tag dialog appears.

4. Optionally, change the name or description of the tag.

5. Optionally, clear the Save as query option to remove the tag from theQueries pane.

Deleting a Tag

You can delete one or more tags at a time.
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Complete the following steps to delete a tag:

1. Right-click in theQueries pane and clickManage Tags.
2. Select one or more tags that you want to delete.

3. Click theDelete Tag button .

Applying a Tag to Query Results

You can use queries to apply a tag to many images at a time.

To apply a tag to all of the images that match a query, complete the following steps:

1. Right-click in theQueries pane and clickManage Queries.
2. Select a query for which you want to apply a tag.

3. Click the Tag Records button .
4. Select an existing tag or create another tag, then clickApply.
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Preferences Overview

To change the default preferences, click Tools > Preferences in the menu bar.

The following list displays some of the preferences that you can change:

l The history length for queries

l The basemap to display

l The file formats to include in import operations

l The license code

l The logging level

General Preferences

TheGeneral tab of the Preferences dialog includes the following preferences:

l Layout. The option to restore the default window layout. If you move the panes in

GeoGofer, you can use this option to restore them to their default locations.

l Query History. The number of recent queries to save. When you start to enter a query in

the search box of the Table pane, the search box displays query suggestions from the list

of recent queries.

l Query Results. The maximum number of records to display for each page of query res-

ults.
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Map Preferences

Use theMap tab of the Preferences dialog to set the default basemap in GeoGofer. Set a local

basemap or use one of the basemaps included with ArcGIS Online.

You can use local basemaps saved as tile package layers. These files have a .tpk extension.

Alternatively, use one of the basemaps included with ArcGIS Online. By default, the basemap is

set to the Streets basemap from ArcGIS Online.

Import Preferences

Use the Import tab of the Preferences dialog to select the file formats that you want to include

when importing files from directories.

For example, if you do not want to import LAS files, clear the LAS selection in the list of file

formats. For more information on supported file formats, see Supported Image Formats on page

7.

Licensing Preferences

Use the Licensing tab of the Preferences dialog to view your locking code and to enter a license

code.

For more information, see Licensing on page 4.

Logging Preferences

Use the Logging tab of the Preferences dialog to set the log level, change the log file name,

and view the current log file.

Log Level

You can select one of the following log levels:

l Off

l Error

l Warning

l Info

l Verbose

Log File Name
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Click the Log file name button to change the name of the log file. You can also change the loc-

ation of the log file. However, the log file must always have a .log file extension.

Open Current Log File

Click theOpen current log file button to view the log file.
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Administration Overview

Complete administrative tasks to configure ArcGIS Online settings and to manage the GeoGofer

database.

ArcGIS Online Administration

For most tasks that you perform in GeoGofer, GeoGofer communicates with ArcGIS Online in the

background. However, you may want to access the ArcGIS Online web interface to configure

ArcGIS Online settings and to verify service availability.

ArcGIS Online Performance

To ensure optimal performance for GeoGofer, configure your organization's ArcGIS Online set-

tings to allow nonstandard SQL queries. You must be an organization administrator to configure

ArcGIS Online settings.

GeoGofer uses nonstandard SQL queries to display a large number of query results and to query

for images quickly. To allow nonstandard SQL queries, open a web browser and sign in to

ArcGIS Online with an administrator account for your organization. Navigate to your organ-

ization's security settings, and clear the option toAllow only standard SQL queries.

ArcGIS Online Security

GeoGofer always uses HTTPS to sign you in to your ArcGIS Online account securely. However,

GeoGofer sends and receives some information from ArcGIS Online using HTTP. To ensure

secure communication between GeoGofer and ArcGIS Online, configure security settings in

ArcGIS Online.

The following list describes the information that GeoGofer may send and receive using HTTP:
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l Image information. GeoGofer stores information about your images in a database on

ArcGIS Online. The database is hosted as a feature service. When you run queries in

GeoGofer, you access the feature service on ArcGIS Online.

l Basemap information. GeoGofer uses ArcGIS Online basemaps by default. When you

view a location, GeoGofer requests basemap tiles from ArcGIS Online.

l Geocoding information. GeoGofer uses ArcGIS Online as a geocoding service. When

you search for a location in GeoGofer, ArcGIS Online returns coordinates for the location.

To send and receive this information using HTTPS, you must configure your organization's

ArcGIS Online security settings before you run GeoGofer for the first time. The first time that

GeoGofer runs, it creates the GeoGofer database as a feature service on ArcGIS Online. The fea-

ture service is configured to use HTTP unless you have already configured ArcGIS Online to use

SSL only.

IMPORTANT: If you change the security settings after the feature service is created,

GeoGofer will not be able to communicate with ArcGIS Online.

To configure security settings for ArcGIS Online, open a web browser and sign in to

ArcGIS Online with an administrator account for your organization. Navigate to your organ-

ization's security settings, and clickAllow access to the organization through SSL only.

ArcGIS Online Availability

Like any web service, ArcGIS Online may undergo rare periods of unavailability. If you encounter

errors performing tasks in GeoGofer or signing in to your ArcGIS Online account, you may want to

verify service availability for ArcGIS Online.

ArcGIS Online publishes the availability of ArcGIS Online services at the following URL:

http://status.arcgis.com/

GeoGofer uses the following ArcGIS Online services:

l Hosted Feature Services

l Esri Basemaps

l Geocoding
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Database Management

The GeoGofer database is stored on ArcGIS Online as a feature service. From GeoGofer, you

can manage the database to delete it or to check for modified or missing files.

To manage the database, clickManage Database on the Toolsmenu.

Deleting the Database

When you delete the GeoGofer database, the GeoGofer feature service is deleted from your

ArcGIS Online account. Deleting the GeoGofer database clears information for all of the images

imported into GeoGofer.

To delete the GeoGofer database, complete the following steps:

1. On the Toolsmenu, clickManage Database.

TheManage Database dialog appears.

2. ClickDelete Database.

A confirmation dialog appears.

3. ClickDelete.

The GeoGofer application closes and the GeoGofer feature service is deleted from

ArcGIS Online.

NOTE: Alternatively, you can open a web browser and sign in to your ArcGIS Online

account. Then, find the GeoGofer feature service in your list of content, and delete the

GeoGofer service from your account.

Checking for Modified or Missing Files

When you check for modified or missing files, GeoGofer verifies that none of the images in the

database have been modified, moved, or deleted.

To check for modified or missing files, complete the following steps:

1. On the Toolsmenu, clickManage Database.

TheManage Database dialog appears.
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2. ClickCheck for Modified or Missing Files.

A confirmation dialog appears.

3. ClickYes.

The operation runs in the background and changes the status of modified or missing files.

For more information, seeChanging the Status of an Image on page 9.

TIP: To view a list of all themodified or missing images, run a query for images

whose status does not equal imported. For example, youmight enter the fol-

lowing query text into the search box of the Table pane:
Status:!Imported
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